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Preface

This documentation provides information on installing and setting up Super Natural. The
documentation is organized in the following parts:

How to install Super Natural under the z/OS, BS2000/OSD and
z/VSE operating system.

Installing Super Natural on Mainframes

How to set up and customize Super Natural.Setting up Super Natural
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This section describes how to install Super Natural Version 8.2.3 (language-dependent and lan-
guage-independent Natural objects) under z/OS, BS2000/OSD and z/VSE.

■ Prerequisites
■ Installation Jobs
■ Using SystemMaintenance Aid
■ Personal Database
■ Contents of the Distribution Medium
■ Installation Procedure

Prerequisites

Installation

The following softwaremust be installed and running at your site before you install SuperNatural:

■ Adabas for Mainframes
■ Natural for Mainframes

For product/version dependencies, refer to Natural and Other Software AG Products in the current
Natural Release Notes for Mainframes.

Transaction Modes

The following table lists the requirements which must be fulfilled in order to use certain Super
Natural transaction modes.

RequirementTransaction Mode

Natural Advanced Facilities or Com-plete must be installed.Destination PRINTER

The operating system and TP monitor system used must support
Natural work file access.

Destination WORK FILE

Entire Connection must be installed.Destination PC

Con-nect must be installed.Destination or Report Type Con-nect

For information on the supported versions of the Natural add-on products mentioned in the table
above, refer to Natural and Other Software AG Products in the current Natural Release Notes for
Mainframes.
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Installation Jobs

The installation of Software AG products is performed by installation jobs. These jobs are either
created manually or generated by System Maintenance Aid (SMA).

For each step of the installation procedure described below, the job number of a job performing
the corresponding task is indicated. This job number refers to an installation job generated by
SMA. If you are not using SMA, an example installation job of the same number is provided in
the job library on the Natural installation medium; you must adapt this example job to your re-
quirements.

Using System Maintenance Aid

For information on using the Software AG product System Maintenance Aid, see the System
Maintenance Aid documentation.

Personal Database

The SuperNatural personal database is the physical Adabas file that accommodates SuperNatural
user files as shown in the following diagram:
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Contents of the Distribution Medium

SuperNatural is distributed as either a Special PurposeMediumor a SystemMaintenanceMedium.
The same data set (file) names are used for bothmedia types, whereas volume serial numbers and
the position of the data set (file) on the medium may vary.

All references in this document are made to data set (file) names, and are thus applicable to both
types of media.

For a detailed description of the distribution medium, see The Software AG Product Delivery Report
which accompanies the medium.

Data Set (File) Names

Data set (file) names on Super Natural distribution medium are made up of three parts. The fol-
lowing is an example of a data set (file) name:

NSNvrs.INPL

A Software AG product abbreviation forms the first part of the data set (file) name. Each data set
(file) name contains one of the following:

■ NSN for Super Natural
■ NZy for Super Natural Language Module, where y is replaced by the language code letter of the
language you want to install.

The second part of the name, represented by vrs, is substituted by the version, release and system
maintenance level number of the software on your medium.

The third part of the name (the four letters after the period) denotes the type of data set (file). For
example, INPL denotes a library of Natural modules.

List of Data Sets (Files)

The distribution medium contains the following data sets (files) as standard labeled files.

NSNvrs.SYSF - Physical User File

This data set (file) contains the physical file description of the Super Natural physical user file in
ADAULD format for use by the Personal Database.
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NSNvrs.INPL - Language-Independent Objects and Master DDM for Personal Database

This data set (file) contains Super Natural language-independent modules in INPL format for
loading into theNatural system systemfile (FNAT). It also contains themasterDDM (DataDefinition
Module) for the Personal Database for loading into the Predict system file (FDIC).

NZyvrs.INPL - Language-Dependent Objects for Super Natural

This data set (file) contains Super Natural language-dependent maps (source and object modules)
and programs.

NZyvrs.ERRN - Error Messages (Language-Dependent)

This data set (file) contains the Super Natural error message texts for loading into the Natural
system file (FNAT).

NZyvrs.HLPS - Help Texts (Language-Dependent)

This data set (file) contains Super Natural help texts in a form suitable for loading into the Natural
user file (FUSER) by the batch Natural program SNLOAD (this program is included in data set (file)
NSNvrs.INPL).

Documentation on CD > supernat > tutorial > sample - Sample Application for the Tutorial

Sample application for the Super Natural RPC service on Natural for Windows. Contains the
sample client to load to Natural for Windows.

Installation Procedure

1. Delete former Super Natural versions from the Natural system system file (FNAT)

2. Load system file for personal database: Job I050

3. Load language-independent Natural objects: Job I061

4. Define SYSSN to Natural Security

5. Load language-dependent objects: Job I061

6. Load language-dependent help texts: Job I200

7. Load the sample application
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Step 1: Delete former Super Natural Versions from the Natural System File

Exception: Do not delete the following modules stored in the library SYSSN:

Z-DOCVAR
Z-VARSYM
Z-110
Z-120
Z-210
Z-220

Con-nect Modules

NSSNSPFI
NSSNSPFL
NSSNSPUL

Natural Security Modules

PRDNSPED
PRDNSPFA
PRDNSPFI
PRDNSPRL
PRDNSPSF
PRDNSPWF

Predict Modules
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Step 2: Load System File for Personal Database

■ (Job I050, Step 0400 NSNvrs.SYSF)

Note: For SMA Users:
If you want to continue using your old system file, check that the NSN-FIRST-INSTALL
parameter is set to NO.
For Non-SMA Users:
If you want to continue using your old system file, ignore this step.

Load the NSNvrs system file as delivered on the installationmedium using the ADALODutility.

The size of this file should be based on the size of your production environment. The following
is a list of sample values:

DBID=7
NAME=FNSN
FILE=20
ISNREUSE=YES
NISIZE=200B
UISIZE=100B
DSSIZE=100B
MAXISN=1000
VERSION=7
USERISN=YES

Step 3: Load language-independent Natural Objects

■ (Job I061, Step 0400 NSNvrs.INPL)

Job I061 performs the following SMA steps:

The INPL utility loads the programs (maps, subprograms etc.) for Super Natural processor,
administration and personal database and the master DDM for personal database.

For the personal database master DDM, use the following input for CMSYNIN:

INPL B

Otherwise use the following input for CMSYNIN:
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INPL L

The Super Natural modules are loaded into the library SYSSN on the Natural system system file
(FNAT).

The following modules are loaded into the library SYSTEM on the Natural system system file
(FNAT):

LAYGEDUMLAYCHINA

NRM-INPILOADGDA

NRMPRFDNRM-INPL

SNLOADSNLIB

SNSWISASNRTE

SNTENDESNTEND

SRNWSISPPRWF

When the INPL is completed, you receive two messages confirming that Super Natural and the
Natural Report Manager profiles for Super Natural have been successfully installed. If these
messages do not appear, Super Natural is not correctly installed.

Step 4: Define SYSSN to Natural Security

For information on defining SYSSN to Natural Security, see the Natural Security documentation.

Step 5: Load language-dependent Objects

■ (Job I061, Steps 04n1 NZyvrs.INPL, 04n2 NZyvrs.ERRN)

Job I061 performs the following SMA steps where n is replaced by the language code number
of the language you want to install:
■ Step 04n1 NZyvrs.INPL

Loads the language-dependent Natural objects (programs and maps).

Users not using SMA can issue the following command for CMSYNIN:

INPL L

■ Step 04n2 NZyvrs.ERRN

The ERRLODUS utility loads the Super Natural error messages into the Natural system file
(FNAT).

Users not using SMA can issue the following commands, as in the following example:
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LOGON SYSTEM
ERRLODUS
FIN

Step 6: Load language-dependent Help Texts

■ (Job I200, Step 04n3 NZyvrs.HLPS)

The program SNLOAD loads the SuperNatural help texts into theNatural user systemfile (FUSER).

Users not using SMA can issue the following commands, as in the following example:

LOGON SYSSN
SNLOAD
FIN

Step 7: Load the Sample Application

Load the sample application forNatural forWindows from theDocumentationCD (Documentation
CD > supernat > tutorial > sample) to your Natural for Windows environmemnt.

The SuperNatural RPC service objects, resulting from the tutorial samples 9, 10 and 11 are available
on the library SYSSN on theNatural system system file (FNAT):

RPCSMPL3RPCSMPL2RPCSMPL1

The are intended to be compared with your own results if you proceed with the samples. You can
copy the objects into the library NSNSAMPL on the Natural user system file (FUSER) to execute them
with the sample application for Natural for Windows via RPC.
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This chapter describes how to set up Super Natural to suit your environment and covers the fol-
lowing topics:

■ Setting Up Super Natural Without Natural Security
■ Setting Up Super Natural With Natural Security
■ Set-Up for the Super Natural Personal Database
■ Buffer Sizes
■ Natural User System File (FUSER)
■ Natural Library SYSSN

■ Customizing Super Natural (System Exits)
■ Super Natural in Inverse Mode
■ Setting up the Environment for the Super Natural Tutorial

Setting Up Super Natural Without Natural Security

To initialize Super Natural

■ Execute the Super Natural initialization function with:

LOGON SYSSN
SNINIT

The userDBAand the default user ******* are defined and the SuperNatural Administration
Application is invoked.

The administrator is defined as an authorized user whomay use the Super Natural Adminis-
tration Application.

To add / link users and files

■ Add/link additional users and files to Super Natural using the Super Natural Administration
Application as described in the following instruction.

To define files and users

When Natural Security is not installed, the following sequence is recommended when defining
files and users to Super Natural:

1 Define files to Super Natural using the Add Files function.

Installation and Set-Up12

Setting up Super Natural



Note: For DL/I files, the options Physical Read Allowed, Display Values for Key

Fields and Adabas Sorting Allowedmust be set to N.

2 Set default user options by modifying the default user *******.

Note: The user options of the default user ******* are used as a basis when adding
Super Natural users.

3 Define users to SuperNatural using the Add User function, and create a file list for themusing
either the Modify User >Files function or the Modify File >Users function.

Nowfiles are defined to SuperNatural, users are defined to SuperNatural with default user option
settings, and each user definition includes an associated file list. You can now modify users and
files further using the Modify User and Modify File functions.

The hierarchy of the specific file and user option settings is discussed in the Administration docu-
mentation.

Caution: Do not use theNatural utility SYSMAIN or SYSMAIN2 to copy or move Super
Natural transactions between system files. These utilities only copy up to 80 characters per
source line and Super Natural specifications contain up to 250 characters per line.

Setting Up Super Natural With Natural Security

When Natural Security is installed, the application SYSSNmust be defined (without protection) to
the Natural Security system before it can be used.

Note: If Super Natural replaces an existing older version running with Natural Security,
remove the startup program MENU from the library profile SYSSN (this prevents installation
errors when loading help texts with SNLOAD). After the installation is completed, set the
startup program again to MENU.

SYSSNmust be installed with Programming Mode Reporting.

To define mandatory command processors to Natural Security

1 Link the following command processor to the application SYSSN using Additional Options in
Functional Security:
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Super Natural MaintenanceMNSPCMD1

2 Set the Keyword defaults to ALLOWED.

3 Link the following command processors to the library SYSLIB using Additional Options in
Functional Security:

Natural Report Manager - MaintenanceNRMNSNS1

Natural Report Manager - TestingNRM-CMD1

4 Set the Keyword defaults to ALLOWED.

To define language-dependent command processors to Natural Security

1 Link the following command processor to the application SYSSN using Additional Options in
Functional Security:

Super Natural Processor
Where n is replaced by the language code number of the language you want to install.

NSP-CMDn

2 Set the Keyword defaults to ALLOWED.

3 Link the following command processors to the library SYSLIB using Additional Options in
Functional Security:

Natural Report Manager - ProcessorNRMNSN0n

Natural Report Manager - Testing
(not necessary if installing English version)
Where n is replaced by the language code number of the language you want to install.

NRM-CMDn

4 Set the Keyword defaults to ALLOWED.

To initialize Super Natural

1 Execute the Super Natural initialization function with:

LOGON SYSSN
SNINIT

The administrator is defined as an authorized user who may use the Super Natural Mainten-
ance System.
The user DBA and the default user ******* are defined and the Super Natural Maintenance
System is invoked.
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2 The Super Natural administrator should now define additional authorized Super Natural
users and files as described below.

To modify the application SYSSN

Once SNINIT has been executed successfully, do the following:

1 Modify the application SYSSN to people protected.

2 Allow command mode.

3 Set the startup and restart programs to MENU.

4 Set the error program to SNRTE.

To link users and files

1 Link at least one user to the application.

2 Link private files to be used to library SYSSN.

3 Add/link users and files to SuperNatural using the SuperNatural AdministrationApplication
as described in the following instruction.

To define files and users

WhenNatural Security is installed, it is recommend that the following sequence be followedwhen
defining files and users to Super Natural:

1 Set default user options by modifying the default user *******.

Note: The user options of the default user *******are used as a basiswhen addingSuper
Natural users.

2 Import users and their associated private files to Super Natural by using the Import User
function.

Only private files that are linked to application SYSSN are available for this function.

Note: For DL/I files, the options Physical Read Allowed, Display Values for Key

Fields and Adabas Sorting Allowedmust be set to N.

3 Import public files to Super Natural by using the Import File function.

Note: For DL/1 files, the options Physical Read Allowed, Display Values for Key

Fields and Adabas Sorting Allowedmust be set toN.
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4 Modify users' file lists by using the Modify User >Files function to add public files to their
file lists, or modify the public files' users list by using the Modify File >Users function.

Nowfiles are defined to SuperNatural, users are defined to SuperNatural with default user option
settings, and each user definition includes an associated file list with private and public files that
can be used through Super Natural. At this point, individual option settings may be changed for
files and users using the Modify User and Modify File functions.

The hierarchy of the specific file and user option settings is discussed in the Administration docu-
mentation.

Note: for BS2000/OSD users:
If you wish to run batch while online, ETID parameters must not be generated (see the
Natural Security documentation).

Caution: Do not use the Natural utility SYSMAIN or SYSMAIN2 to copy or move Super
Natural transactions between system files. These utilities only copy up to 80 characters per
source line and Super Natural specifications contain up to 250 characters per line.

Set-Up for the Super Natural Personal Database

ThemasterDDM for the SuperNatural personal database is cataloged onDatabase 0, FileNumber
90 in accordance with the following naming conventions:

It shows the compatibility format to former Super Natural versions and can be used if the DBID
and FNR are in the following range.

0 - 254DBID

1 - 255FNR

The general format for the master DDM enabling even for a DBID greater than 255 and/or a FNR
greater than 255 is as follows:
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The DBID and FNR are in the following range:

0 - 65535DBID

1 - 5000FNR

The DBID and FNRmust be renamed and recataloged to correspond to the actual DBID and FNR
of the Adabas file installed in Step 2 of the installation procedure. This DBID and FNR must also
be entered in the options User File Adabas Database ID and User File Adabas File Number
(see User Options).

Note: SYSSNmust not be renamed.

If there are inconsistencies in the user and default options, users receive one of the following error
messages when invoking the File List screen:

Natural ErrorAdabas Response Code

NAT3148148

NAT3017017

NAT3061061

It is also possible to have multiple Personal Databases (one physical Adabas file required per
Personal Database). Use of these files is defined by these DBID and FNR option settings.

The field list may be restricted within the DDM, thus enabling the Super Natural administrator
to control the use of the file.

Note: The field with the Adabas short name AA must never be changed.

If Natural Security is installed, note that all user files created on the Personal Database will auto-
matically be defined asNatural Security private files and automatically be linked to the application
SYSSN.
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Buffer Sizes

The size of the Natural runtime buffer is determined by the Natural profile parameter RUNSIZE,
and the size of the user-buffer extension area is determined by the profile parameter ESIZE (see
theNatural Parameter Reference documentation). We recommend the following parameter settings:

SizeBuffer

20RUNSIZE

45ESIZE

ESIZE is dependent on the size of the DDMs you are dealing with and the number of fields used.
Some transactions may need larger values than those listed above.

For an example of the buffer sizes needed by the transactions SAMPLE2 and SAMPLE3 (described
in the Tutorial), see Technical Information.

Natural User System File - FUSER

Super Natural uses the Natural user system file (FUSER) to store and maintain the following:

Authorized Users
A record is maintained for each Super Natural user. The record contains the user's default
options, a list of the files which the user is authorized to access and an entry for the user's au-
thorization to the Super Natural Maintenance System.

Note: The profiles of the Natural Report Manager are stored on the Natural system
system fileFNAT.

Files
A record is maintained for each file on which Super Natural transactions are to be performed.
These files must have a corresponding Natural DDM in the dictionary file (FDIC).

Transaction Programs
When a user saves or runs a new transaction, a Natural program is generated from the trans-
action specification and this program is saved and cataloged like any other Natural program.
The transaction specification information is stored as comment lines at the beginning of the
generated Natural program to facilitate transaction modification.

The Natural library name used for transaction programs is generated as follows:
The first character is the private library prefix (default Y).
The second through eighth characters are the User ID of the user.
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Super Natural also supports read-only public libraries which have corresponding Natural
libraries where the first character is the public library prefix (default Z). A transaction may be
copied into a public library using the SuperNaturalMaintenanceApplication. The transaction
program names in both private and public libraries are constructed as follows:
The first character is the transaction prefix (default I)
The second through eighth characters are the Transaction ID as specified by the user.

Common Libraries
List of common libraries.

Help Text
Super Natural help texts.

Note: If you are using a new Natural system user file (FUSER), use the utilities SNULD and
SNLOAD to move Super Natural data created in a former Natural environment.

Natural Library SYSSN

SYSSN is the Super Natural system library. SYSSN is in the Natural system system file (FNAT) and
is used to store and maintain the following:

Super Natural System Programs

TheNatural programs comprising the Super Natural system are provided in INPL object form for
loading (using the Natural INPL facility) into the Natural library SYSSN.

System Exits

The system exit programs SPRJEU, SPPARM, EXIT, SNERRU and ENTRY are provided in source form
which you can modify. For further information, see Customizing Super Natural.

Batch Utilities

The batch utilities SNULD, SNLOAD and SNDELUF are provided in object form. For further in-
formation, see Batch Utilities.
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Error Logging

SNELOG
Service program for reviewing the error protocol. You can use the error protocol to see
whether errors are environment-specific, for example, size problems, or printer or work file
assignment problems. For further information on error logging, see Error Logging.

Status Reporting

SNTALOG
Service routine for reviewing Status Reports written if the option DDM Check on Modify is set
and deviations are detected in a transaction.

SNTAON
Service routinewhich activates status reporting. The Status Reports arewritten to the Personal
Database. If you invoke SNTAON using the NOUSER parameter, user IDs are not recorded in the
status report.

SNTAOFF
Service routine which deactivates status reporting. It deletes all Status Reports

Customizing Super Natural - System Exits

In the library SYSSN, Super Natural provides the following system exit programs in source form,
whichmay bemodified to customize SuperNatural to the needs of your user site. At the beginning
of each program, there is a detailed program description.

EXIT
Program invoked as exit routine when the Super Natural session is terminated.

SNERRU
Program invoked by error routine SNRTE. SNERRU can be modified to handle specific error
conditions. For example, you can use SNERRU to give the user additional information or instruc-
tions when an error occurs.

SPRJEU
Natural subprogram which is executed once for every job card prior to the submission of a
batch job.

SPPARM
Subprogram to define environment specific parameter settings. Parameters include:
- The submission indicator for batch job submission (RJE or NPR)
- Com-plete hardcopy support - default printer number generation or prompting for destination
(default)
- Common library prefix character
- Layout prefix character
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ENTRY
Program invoked as entry routine for the Super Natural session.
The Report function displays a list of errors showing date, time, error number, type of error,
program, line and user (if not deactivated using the NOUSER parameter). If youmove the cursor
to an error line and press ENTER, you receive further information concerning the error.
The Delete function deletes the current list of errors.

SHEXIT
Program which takes over if the user presses CLEAR.

Super Natural in Inverse Mode

Using Super Natural inverse mode, you can display right-to-left languages (such as Arabic and
Hebrew) provided that the appropriate hardware facilities are available. All input and output
fields are displayed in inverse mode.

The SuperNatural administrator defineswhich language code each userwill use for inversemode
by setting the user option Language Code for Inverse Mode in that user's user profile. For further
information, see Users. If the user selects this language code in his/her user profile, the terminal
display is switched.

If the files Super Natural users are accessing in inverse mode contain only data in inverse format,
no further set-up requirements need be considered.

Files with Mixed Data Format

If a file contains both fields with data in regular format (to be displayed from left to right) and
fields with data in inverse format (to be displayed from right to left), the Super Natural adminis-
trator must prepare the Super Natural environment accordingly.

Super Natural must be able to distinguish between fields of regular and inverse format for all data
maintenance and reporting functions. If this distinction is not made, both field types are treated
alike and the resulting data is unusable. If the distinction between regular and inverse format data
is made, Super Natural can display regular format fields from left to right when accessing the
mixed file in inverse mode.

So that Super Natural can distinguish between the two field types of a mixed file, fields with reg-
ular format must be indicated by a prefix in the field namewhen the file is designed. For example,
you could define regular format fields with the prefix reg-, as in REG-NAME, REG-CITY, etc. This
prefix must also be specified in the mixed file's file option Prefix for Inverse Field Output.
Users do not need to distinguish between the two field types when operating in inverse mode as
Super Natural adjusts the corresponding field formats automatically. Users can maintain and
display data of any field type regardless of field format.

Youmust consider the followingwhen operating Super Natural in inverse modewithmixed files:
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■ Define all names of fields that are to contain data in regular format (from left to right) with a
prefix when creating the file.

■ Use the same prefix for the file's option Prefix for Inverse Field Output.
■ Set the option Language Code for Inverse Mode to the appropriate code for each user who
is to operate in inverse mode.

■ Advise users to only access mixed files in inverse mode.

Setting up the Environment for the Super Natural Tutorial

If you proceed with the examples 9 to 11 of the Tutorial you have to provide the data you have
selected with the transaction to your Natural for Windows environment for further processing.

The following steps describe how to load the example application from the Documentation CD
and to set up your environment.

To load the example application

If you want to set up your Natural for Windows in order to use the Super Natural RPC Service,
set up the NATPARM parameter module according to the recommondation. For further information,
see theNaturaldocumentation sectionRemote Procedure Call > Setting up aNatural Client. Furthermore,
ensure that your connections and servers are active.

1 Open Natural for Windows.

2 Execute the Natural for Windows Unload Utility by selecting System Libraries > SYSUNLD
> Programs > Menu.

The Unload Utility window appears:

3 Enter L in theCode field.

4 Press ENTER.

5 Select theWork button and enter the path of the workfile you want to load to your Natural
forWindows environment:Documentation CD\supernat\tutorial\sample\NSNsampl.SAG.

6 Press ENTER.

7 Enter A in the Code field to determine that you want to load all data.

8 Press ENTER until you reach the screen of Step 7.

All data for the sample application is loaded.

9 Exit the Unload Utility by entering . in the Code field.
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To set up your Natural environment for the tutorial example data

1 Go to the user library you expect the sample application (here NSNSAMPL) and refresh it.

NSNSAMPL is placed in the user library now.

2 Execute System Libraries > SYSRPC > Programs > Menu.

3 Select Tools > Local Service Directory Maintenance.

4 Add the library NSNSAMPL and the corresponding subprograms RPCSMPL1, RPCSMPL2 and
RPCSMPL3.

5 Select OK.

6 Go to the library SYSRPC > Subprograms and copy the subprogram NATCLTGS to the library
NSNSAMPL > Subprograms.

Your Natural environment is now ready to use for the tutorial RPC examples.
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